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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 1993-2012 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

Microsoft®, Windows®, Windows Server®, Windows® XP, and Windows® 7 are U.S. registered trademarks 
of Microsoft Corporation.  

Windows VistaTM is either a registered trademark or trademark of Microsoft Corporation in the United 
States and/or other countries. 

Java™ is a US trademark of Oracle Corporation. 

UNIX® is a registered trademark of The Open Group. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated. 

Pentium® is a registered trademark of Intel Corporation or its subsidiaries in the United States and other 
countries. 

This product includes software developed by the Apache Software Foundation (http://www.apache.org/). 

For additional licensing information about third party and open source software, see the 
open_source_and_third_party_licenses.pdf file in the bin\documentation folder on the DDM 
Inventory 9.32 distribution media. 
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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html
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HP Discovery and Dependency Mapping 
Inventory 

Release Notes 
Software version: 9.32 / April 2012 

This document provides an overview of the changes made to Discovery and Dependency Mapping Inventory 
(DDM Inventory) for version 9.32. It contains important information not included in the manuals or in the 
online help. 

Conventions Used in this Document  

In This Version 

New Features 

Compatibility Notes 

Scanner Support Information 

Obsolete Features 

Documentation Updates 

Installation Notes 

Enhancements and Fixes 

Known Problems, Limitations, and Workarounds 
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Conventions Used in this Document  
By default, when you install the DDM Inventory Server software, all the components will be in one of the 
locations specified in the following table. The placeholders are used to represent the DDM Inventory 
program and data folders referenced in this document: 

Folder Placeholder Platform Default Location 

Program 
Files 

<InstallDir> Windows  
Server 2008 x64 

C:\Program Files (x86)\Hewlett-
Packard\DDMI\9.32 

All others C:\Program Files\Hewlett-Packard\DDMI\9.32 

Data 
Files 

<DataDir> Windows  
Server 2008 

C:\ProgramData\Hewlett-Packard\DDMI 

Windows Server 
2003 

C:\Documents and Settings\All 
Users\Application Data\Hewlett-Packard\DDMI 

You can customize both of these locations when you install the DDM Inventory Server. 
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In This Version 

Introduction 

These release notes are for DDM Inventory 9.32. This new version of the product is the upgrade path for 
users of DDM Inventory 7.6x, 7.70, and 9.3x.  

If you want to see what features have been introduced in previous versions of DDM Inventory (formerly 
called Enterprise Discovery), you can read the Release Notes for those versions available on your installation 
CD under bin\documentation.   

License Schema 

Each DDM Inventory server is limited to holding a maximum of 50,000 inventoried devices, 60,000 
discovered devices, or 150,000 discovered network ports (whichever occurs first). A DDM Inventory 
Aggregator can support up to 50 servers and up to 500,000 devices. 

From DDM Inventory 9.31 onward, the port limitation is increased to 500,000 with a non-NMS license.  

Updated Third-Party Components     

There are no updated third-party components in this version. 
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New Features  
DDM Inventory 9.32 provides several new features to extend existing functionality and provide users with 
new capabilities. The following section describes these features. 

Enhanced Support for Solaris Zones 

When running the scanner in the local zone scan mode, DDM Inventory can determine the parent/child 
relationship between the physical host devices and the virtual devices (zones) that are hosted on the physical 
devices. The device information is displayed in the Virtual Devices Window, Device Manager, and the 
Virtual Device Reports. For more information, refer to the “Virtualization and Enterprise Discovery” chapter 
in the Reference Manual.  

To switch from global zone mode to the local zone mode, perform the following: 

• Disable the generation of local scan files from the global scan file. 

Select Administration > System Configuration > Scan Processing. 

For the Generate Solaris local zone inventory from the global zone option, select Custom, 
and then select No. 

• Run the Scanner Generator to produce a new configuration file for the Solaris scanner. 

On the Miscellaneous tab, clear the Non Global zone (Solaris) check box 

NOTE: After upgrading to DDM Inventory 9.32, device information for Solaris Zones is purged 
automatically. This device information will not appear on the reports until the devices are rediscovered. 

Enhanced Rule-Based Recognition 

Rule-based recognition has been enhanced in DDM Inventory 9.32 for installed packages.  

A new page is added to the Application Rule wizard that specifies how the main file is selected. You can 
specify file name, directory, and file type attributes that are included or excluded from the selection criteria. 

For more information, refer to the SAI Editor online help. 

New Scanner Platform  

The following platforms are now fully supported (scanner/agent/software utilization). 

• Oracle Linux 4, 5, 6 

• CentOS 5, 6 

• Oracle Solaris 11 

• Apple Mac OS X 10.7 

For more information, refer to the Compatibility Matrix. 

Scanner Enhancements  

• The logic of software scanning is optimized to significantly reduce the CPU usage.  
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• The CPU detection logic is updated and supports new CPUs for Solaris and AMD as follows: 
o Solaris: SPARC64-IV, SPARC-T3, and UltraSPARC-T4 
o AMD: C60, A4, A6, A8, E2, E-300, E-450, FX Quad-Core, FX Six-Core, and FX Eight-Core 

Analysis Workbench Enhancements 

You can choose to not perform recognition during the re-recognition process by selecting a new option in the 
Analysis Workbench. Using this option can save time when a lot of scan files are loaded into the Analysis 
Workbench. 

For more information, refer to the Scan Data Analysis Guide. 
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Compatibility Notes  

Reports Database Changes 

Additions 

• The fLanguageCode column has been added to the Aggregate.File table. 

• The Aggregate.hwsmbiosPhysicalAttributes table has been added.   



10 

Scanner Support Information  
Scanner and agent support for the following platforms was removed as of release 9.32: 

Platform Last Release Providing Support 

Oracle Solaris 8 Discovery and Dependency Mapping Inventory 9.31 

Apple Mac OS X 10.4, 10.5 (PPC) Discovery and Dependency Mapping Inventory 9.31 

 

All other Scanners and Agents supported in the 9.31 release of this product are supported in the 9.32 
release. Refer to the Compatibility Matrix for the 9.32 release for the list of all supported platforms. 

 
When upgrading from a previous release, it is possible to use the Scanners and Agents from 
previous releases (7.70 and 9.3x) if you explicitly specify the Scanner and Agent versions using 
the configuration options on the following pages: 
Administration > System Configuration > Scanner deployment 
Administration > System Configuration > Agent communication 
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Obsolete Features  
All the features in DDM Inventory 9.31 are supported in DDM Inventory 9.32. For further information, 
please see the Compatibility Matrix. 

 



12 

Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site: 
http://www.adobe.com/ 

The following PDF documents are available in the DDM Inventory Web UI: 

• Planning Guide  

• Installation and Initial Setup Guide 

• Configuration and Customization Guide 

• Network Data Analysis Guide 

• Scan Data Analysis Guide 

• Reference Guide 

http://h20230.www2.hp.com/selfsolve/manuals�
http://h20229.www2.hp.com/passport-registration.html�
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Installation Notes 
Instructions for installing DDM Inventory are documented in the Installation and Initial Setup Guide 
provided in Adobe Acrobat (.pdf) format.  

 Perl, MySQL, Tomcat and Apache are standard parts of the DDM Inventory, included with each 
server installation. If you have these components installed already, make sure to remove them 
before installing DDM Inventory. You may NOT substitute any other technologies in place of the 
standard installation. 

Software and Hardware Requirements  

The following sections detail the requirements for the DDM Inventory server and client components, 
respectively. 

Client Requirements 

The DDM Inventory client components (Analysis Workbench, SAI Editor and Viewer) have the following 
requirements: 

Resource Requirement 

Operating System Windows XP/Vista, Windows Server 2003/2008, Windows 7 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

See Help > Compatibility Matrix in the DDM Inventory GUI for 
versioning information 

Server Requirements 

The DDM Inventory Server can be installed on 32-bit versions of Windows Server 2003 (SP1, SP2), Windows 
2003 R2, or Windows Server 2008 (SP1), and the 64-bit version of Windows Server 2008 (SP1 or SP2) or 
Windows 2008 R2 (SP1). For information about all supported platforms, refer to the Compatibility Matrix. 

Recommended Server Platforms 

For large servers (up to 50,000 devices), the following is recommended: 

• HP Proliant Model: DL380 G7  

• CPU: 8 Core (Intel® Xeon® 5600 series)  

• Memory: 8 GB 

• Disk: See the Storage Requirements section below. 

For medium servers (up to 15,000 devices), the following is recommended: 

• HP Proliant Model:  DL380 G7  
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• CPU: 4 Core(Intel® Xeon® 5600 series) 

• Memory: 6 GB 

• Disk: See the Storage Requirements section below. 

Sample Server Scenarios 

The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6GB for the DDM 
Inventory installation. 

The information presented below is for illustrative purposes only.  Proper sizing of the DDM Inventory 
server(s) may require assistance from a qualified architect.  HP recommends utilizing experienced resources 
to assist in architecture and the initial deployment of DDM Inventory.  Among the factors that need to be 
considered and which will impact the infrastructure architecture are the following: 

• Number of and distribution of devices (such as if slow WAN links exist between large population groups) 

• Type of and amount of information collected (examples below demonstrate the impact software 
utilization will have on overall system capacity) 

• Frequency of scans (the example below assumes a bi-weekly scan interval, more frequent scanning may 
require additional server capacity) 

• Amount of data collected (the examples below assume an average scan file size of ~250KB, which is 
representative of an average PC (large servers may generate considerably more data and therefore require 
additional capacity to process the data) 

• Environmental factors, such as integrations with other products, network characteristics, and 
operational requirements may impact the architecture of the DDM Inventory solution 

• The number of XML Enrichers that are running on the server 

• The settings in the virus checker installed on the server. Virus checking can add significant overhead. 

Table 1 – Suggested Hardware Requirements 

Discovered 
Devices 
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Devices Ports A
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Memory 
(GB) CPU** 

Disk 
(GB) 

6,000 5,000 36,000 
 

x  1.5 
1 CPU 
2.4 GHz 25 

6,000 5,000 36,000 
 

x x   3*** 
1 CPU  
2.8 GHz 40 

  18,000 15,000 108,000 
 

x  
   2 

2 CPUs or cores 
3.0 GHz 70 

18,000 15,000 108,000 
 

x x 5 
2 CPUs or cores 
3.0 GHz 105 

60,000 50,000 150,000 
 

x  4 
2+ CPUs or cores 
3.6 GHz 200 

60,000 50,000 150,000  x x 7 2+ CPUs or cores 260 
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Discovered 
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Memory 
(GB) CPU** 

Disk 
(GB) 

3.6 GHz 

50,000 50,000 n/a x n/a n/a 2 
2 CPUs or cores 
3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 20 

2 CPUs or cores 

3.6 GHz 200 

* DDMI Topology is a network management component of DDM Inventory. It is no longer available for sale 
to new customers, but still available to existing Topology customers. 

** CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 
performance than those shown in the table. HP DDM Inventory consists of multiple processes, many of 
which are also multi-threaded. As a result, it benefits from Simultaneous Multi-Threading (SMT) 
technologies such as Intel® Hyper-Threading and Multi-core. 

*** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

These calculations have been tested as scenarios for maximum disk size on the server.  

For the Inventory license, this includes: 

• “Backup Scan Files” is enabled (on average, each scan file is 250KB) 

• “Delta scanning” is enabled 

• Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

• “Statistic Export” is enabled (CSV files) 

• 200 users, with each user account saving 10 map configurations files 

• Space required for two backups (one stored backup, and one “in process” backup) 

Storage Requirements  

DDM Inventory is a highly I/O intensive application. High I/O performance of the disks where the data 
resides is crucial to the correct operation of DDM Inventory. Disks need to reside local to the DDM Inventory 
server or on a high performance SAN.  Network drives and clusters are not supported. Some customers have 
reported problems with SAN environments so they are not recommended.    

Benchmark your disk I/O performance prior to installing DDM Inventory for management of any large 
environment. For a medium to large DDM Inventory server deployment, minimum recommended 
throughput (as benchmarked on an idle system when the DDM Inventory server is not running) is  
70 MB/sec for read accesses and 40MB/sec for write accesses. 

Your disk space requirements may differ depending on how you are using DDM Inventory. 

 For performance reasons, the disk where DDM Inventory data is stored should have at least 4K 
clusters. 

For the average size of scan files, refer to the “Disk Space Considerations” chapter in Installation and Initial 
Setup Guide. The inventory data collected in the scan file is stored in compressed format. For processing, the 
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data is extracted and populated into the database. In addition, if delta scanning is enabled, DDM Inventory 
keeps a copy of the original scan file as well as the enriched copy. Because of these extra disk space 
requirements, we recommend that you budget at least 5 times as much disk space for each device being 
scanned. 

 If your average scan file size is large, adjust your disk space requirements accordingly. 

Recommended Fault Tolerance Configurations 

The recommended fault tolerance configurations are the following: 

• Raid 1 

• Raid 1+0 

DDM Inventory must be installed on a local disk. It cannot be installed on network drives, SAN drives, or 
clustered devices. DDM Inventory has been tested and can be successfully installed in a RAID (redundant 
array of independent drives) level 0 and level 1 environment.   

RAID level 0 uses a striped disk array strategy that does not provide fault tolerance. Data striping spreads 
out blocks of each file across multiple disk drives. In our test environment we use 2 drives. This 
configuration does not provide for redundancy. It improves performance but does not deliver fault tolerance. 
If one drive fails then all data in the array is lost. 

RAID level 1 uses a mirrored set strategy that provides fault tolerance from disk errors and single disk 
failure. It results in increased read performance with very small performance degradation when writing. The 
array continues to operate as long as at least one drive is functioning.  

Because it offers the best tradeoff of performance and reliability, level 1 is the recommended RAID platform 
for DDM Inventory. For large networks, level 0 can also be used if performance is more important than fault 
tolerance. RAID level 5 is not supported. 

Upgrading from Earlier Releases 

For information about upgrading from earlier releases of DDM Inventory refer to the “Upgrade and 
Migration Scenarios” chapter in the Installation and Initial Setup Guide. 
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Enhancements and Fixes 
The following items were added or fixed in the current software release. Table 2 lists enhancements to 
existing features or behavior. Table 3 lists problems that were fixed (identified by error tracking number). 

Table 2 – Enhancements 

Number Location Description 

QCCR1C20012 Scanners 

The scanners now support FTPS/HTTPS for offsite file 
storage when running in manual mode.  For detailed 
information, refer to the Scanners chapter of the Reference 
Guide. 

QCCR1C20028 Windows Scanner 
By default, the Windows scanner will not scan the 
%SystemRoot%/Installer/$PatchCache$ folder. 

QCCR1C20039 Reports 
A new column “Appliance id" is added to the report 
"Remote Server health". 

QCCR1C20388 Scanners 
The scanners now compress the temporarily generated 
files to save disk space. 

QCCR1C32395 Discovery Engine 
When the agent upgrade is off in the agent profile, DDMI 
will not update the agent during the call home workflow. 

QCCR1C34229 SAI Editor 
A new column "Signature" is added to the SAI Search 
dialog for displaying file signature.  

QCCR1C35745 Virtual Discovery 

When scanning a VMware ESXi 5 host remotely via the 
web services API (either using the VMware remote 
scanner or as part of virtualization discovery) the serial 
number of the host can now be collected. 

QCCR1C36168 Xml Enricher 
The hwScanDate field stored in the DDMI server database 
uses the server local time instead of UTC. 

QCCR1H61970 Web UI 

The self-signed SSL certificate used to access the Web UI 
of the DDMI server now has a 2048 bit key.  You will need 
to delete the old certificates to get the new ones generated. 

QCCR1H62056 Scanners 

The HP Blades can be configured to use the virtual serial 
numbers. In such cases the virtual serial number will be 
reported as part of the standard SMBIOS System 
Information. The scanners were enhanced to collect the 
real physical serial number of the blade in the 
hwsmbiosPhysicalAttributeSerialNumber field. The 
physical UUID is also reported in the 
hwsmbiosPhysicalAttributeUUID field. 

QCCR1H63270 Web UI 
A new textbox is added to Diagnosis Ping tool to specify 
the timeout value of the ping command. 
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Number Location Description 

QCCR1H64368 Virtual Discovery 
The virtual discovery can select the correct primary IP 
address for VMware ESX servers. 

QCCR1H64876 Windows Scanner 
The Windows scanner can collect language information for 
files as part of the version data. 

QCCR1H65536 Virtual Discovery 
The virtual discovery supports scanning VMware ESXi 
5.0. 

QCCR1H66199 Agents 

When install and upgrade agent, the call home options 
configured on DDMI server will be updated onto the 
device. 

QCCR1H69169 Windows Scanner 

The Windows scanner can detect Hyper-V virtual 
machines correctly. The Hyper-V host machine will not be 
marked as Hyper-V anymore. 

  

Agent 
Communication 
Server 

The agent communication server can now run commands 
via “sesudo”. This can be configured in Server > Admin > 
Discovery Configuration > Deployment Credentials. 

 

Table 3 - Problems Fixed 

Number Location Description 

QCCR1C20024 Reports 
In the report of "deactivated device", the Column "Method" 
is changed to "Last Seen Method". 

QCCR1C36060 Windows Scanner 

When scanning the 64-bit Windows machines, the relation 
between the 32-bit packages and their files can be collected 
correctly. 

QCCR1C36325, 
QCCR1H64006 Windows Scanner 

The Windows scanner can distinguish Ethernet adapter 
from wireless adapter. The Ethernet IP address will take 
precedence over wireless IP address when setting primary 
IP 

QCCR1H63591 Aggregator UI 

When opening the Device Manager of a device in a remote 
server from the Aggregator UI, the Update Model tools 
work properly now. 

QCCR1H63592 Aggregator UI 
The Update Model commands work properly in the 
Aggregator Find tool. 

QCCR1H63984 Web UI 
Launching applets will not pop up warning message for 
version mismatch. 

QCCR1H64029 Server 
The System Monitor service can run properly without "Java 
heap space" error. 
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Number Location Description 

QCCR1H64030 Web UI 
Agent installation files can be downloaded correctly via the 
web UI. 

QCCR1H64062 AIX Scanner 

The AIX scanner will not collect patch information 
anymore. The amount of patch information on AIX varies 
from machine to machine. If it is huge, processing the scan 
file will be very time consuming. 

QCCR1H64371 Windows Scanner 
The Windows scanner can detect the cluster services 
properly now. 

QCCR1H65538 Linux Scanner The Linux scanner can detect user profiles properly. 

QCCR1H66129, 
QCCR1H67128 Aggregator 

Workstation data can be imported into Aggregate database 
properly now. 

QCCR1H66476 Discovery Engine 
Devices which support SNMPv2 only can be queried now. 
User can add SNMPv2 community strings to SNMP profile. 

QCCR1H66936 Aggregator 
When the rule-based recognition result is imported into 
Aggregate database, the version ID will not change. 

QCCR1H67828 Solaris Scanner 
The Solaris scanner can collect the service pack information 
correctly in Solaris 10 and Solaris 11. 

QCCR1H67929 Scanners 
The scan file can be successfully saved onto FTP server that 
is responding slowly 

QCCR1H67956 Web UI 

The web UI will display proper error messages when the 
users try to import invalid IP addresses into the DDMI 
configuration. 

QCCR1H68577 Web UI 
 The UI Shortcuts are working fine now. For details on UI 
Shortcuts, please refer to the Reference Guide Chapter 9. 

QCCR1H69126 Documentation 

The Named option in the Select Files to Process dialog 
box is described correctly in the Scanner Generator chapter 
of the Configuration and Customization Guide. For detailed 
information, navigate to the following location:  Scanner 
Generator > File Scanning Tab > File Information to Store 
Sub Tab > Including or Excluding Files Based on Directory 

QCCR1H69451 Windows Scanner 
There will be no pop up message when collecting Device 
driver data. 

QCCR1H69501 Documentation 

The difference of viewing software utilization data in the 
Viewer with Scan Data Viewer is stated in the “Software 
Utilization Data” chapter of the Scan Data Analysis Guide. 
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Known Problems, Limitations, and Workarounds  

Agents 

• When the Agent is installed on Windows Vista machines using an account other than the 
"Administrator" account, the firewall exception is not added into the exceptions list (QCCR1C382).  

• The HP-UX Agent may not work if the system name is longer than eight characters (QCCR1C35093). 

Scanners 

• In the Scanner Generator if a previously generated file is used to populate the Scanner Generator 
options and software scanning is disabled, the Scanner will still attempt to store any previously 
configured custom stored files (QCCR1C19042). 

• In some cases an unmanaged device with more than one network card may fail to run the Scanner 
because of an upload error (QCCR1C32128). 

• The DNS field in the scan file that contains the DNS entry for the primary IP may not be detected on 
some UNIX machines if a DNS server is not configured (QCCR1C32533). 

• The Linux scanner may fail and exit when run on SUSE Enterprise Desktop 9 update 4 
(QCCR1C32691). 

• There is a Container state field mismatch between the scan file and Device Manager (QCCR1C34856). 

• The Linux scanner cannot resolve FQDN (fully qualified domain name) when run on Red Hat Enterprise 
Linux 5 (QCCR1C34774). 

• The Windows scanner may fail when the “Packaged File Data” option is enabled (QCCR1C35016). 

Analysis Workbench 

• In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the “Treat field as 
a File Name’’ option is selected, the “Replace invalid characters with’’ field must be populated as well, 
even if the “Delete invalid characters’’ option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (QCCR1C1275). 

• For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (QCCR1C1480). 

• The Analysis Workbench sample script does not run on Windows 2008 because the default directories 
are not set correctly. The script works properly on all other supported platforms (QCCR1C19475). 

Server Installation 

• After uninstalling, the branding registry keys are left over (QCCR1C1434).  

• Non-ASCII characters used in data directory path name can cause problems during the installation 
(QCCR1C16520 and QCCR1C1472). 

• When uninstalling DDM Inventory on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (QCCR1C2405). 

• DDM Inventory with a Network Topology license should not be installed on VMware (QCCR1C5271). 
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• The SNMP extension registry key may not be removed on some Windows 2008 server installations 
(QCCR1C29306). 

• After a new installation, opening the SAI Editor for the first time may show a warning message 
(QCCR1C32445). 

• If DDM Inventory is upgraded from a previous version, the certificate date may not be updated 
(QCCR1C32481). 

• When installing DDM Inventory on Windows Server 2003 SP2, you may receive a digital signature 
policy error. 

Server 

• In some cases, the ID assigned to the auto.zsai and the user.zsai files may be the same. This 
results in the inability to load both files into the client tools at the same time (QCCR1C4448). 

• Older OpenSSL DLLs in the system PATH can affect the DDM Inventory Apache server and Perl 
engines (QCCR1C5447). 

• If your server has another service using port 80, the HP Discovery Apache service will not run properly. 
As a workaround, you can comment out the “Listen 80’’ directive in the httpdf.conf file 
(QCCR1C6670). 

• If there is a MySQL query that takes too long, DDM Inventory will not function properly and you may 
need to restart System Monitor to recover (QCCR1C7409). 

• If two or more VMware virtual machines configured on the same host share the same IP address 
(possible if a virtual network adapter is disabled), VMware discovery may yield incorrect IP address 
information for a virtual machine. This can happen as VMware discovery does not currently detect 
whether a network adapter is disabled (QCCR1C19379). 

• Sometimes when logging into the DDM Inventory server, a pop-up window opens with the message 
“Jscript compilation error: Expected ‘}’”.  This problem occurs as a result of calling Java Applets from 
Internet Explorer (this issue does not seem to occur with Firefox). The problem is not specific to DDM 
Inventory and can be seen on various Web pages where Applets are present. Note that the pop-up 
window opens with this message only if the “Disable script debugging” option is enabled. Otherwise, if 
this option is enabled, only a warning icon (yellow triangle containing an exclamation mark) will appear 
on the left-side of the Internet Explorer taskbar when this problem occurs. This problem has occurred on 
both Internet Explorer version 6 and version 7 (QCCR1C19591). 

• If a non administrative user logs into the Windows server, an error indicating that the syspanel.log 
file cannot be created may occur (QCCR1C20437). 

• If agent and agentless scanning is enabled for a property group, in some cases installing and then 
uninstalling an agent may result in DDM Inventory not recognizing that a device has an agent on it 
(QCCR1C29364). 

System Panel 

• When there are multiple instances of the DDM Inventory System Panel running on the Server, only one 
of the System Panel instances will display Port Usage information (QCCR1C20409). 

Web User Interface 

• After an agentless scan (using SSH) has successfully been run, the account used for this connection 
cannot be changed unless the account from the DDM Inventory UI is deleted (QCCR1C19398). 
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• The hyperlink (5th token) in the breadcrumb is missing for some reports (QCCR1C35014). 

Applets 

• When upgrading, the applet may not recognize a new license until the server has been restarted 
(QCCR1C32483). 

Administration 

• Depending on the licenses, the “Resource/ Environment manage’’ option in Discovery Configuration may 
not have any effect (QCCR1C7034). 

• In the Service Analyzer, device breaks may show up in the filter list for line breaks (QCCR1C18988). 

• If the recognition type is set to Installed Applications, the auto.zsai file will not be created 
automatically (QCCR1C30353). 

Web Asset Questionnaire 

• In Internet Explorer, when connecting to the main page through a proxy server, the “You are connecting 
from’’ IP address reported will be the IP address of the proxy server, and not that of the remote computer 
address (QCCR1C764). 

• The UI may show non-printable characters in text fields (QCCR1C2408). 

Internationalization 

• Various UI screens (reports, status reports, Device Manager, and so on) format the “day of the month’’ 
part of the date as Arabic numerals instead of using the language option configured by the operating 
system (QCCR1C416). 

• When non-ASCII characters are used to define Schedules in the Discovery Configuration, the Status > 
Current Settings > Discovery Configuration may display errors when listing the Configuration Profile 
information (QCCR1C490). 

• There are several problems with the SAI Editor accepting characters in the Korean code page 
(QCCR1C507, QCCR1C508). 

• The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (QCCR1C2043). 

• SAI files with non-English names may appear incorrect when viewing them with the DDM Inventory 
web user interface (QCCR1C19372). 

• If the name of a User zSAI file contains non-English characters, the XML Enricher may not be able to 
load that zSAI file (QCCR1C19402). 

• Recognition rules written in non-English characters may not recognize all versions (QCCR1C19610). 

• Some non-English locales may not report the total disk space correctly in some cases (QCCR1C19614). 
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